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CHAPTER
ONE

COURSE INTRODUCTION

1.1 Foreword

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS,
we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the
functions you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

* It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

o It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

e It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

o Extensive help and documentation is available. If you’re stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

* Cross-platform. QGIS can be installed on macOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.

1.1.2 Background

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.

This training manual is intended to provide all the materials needed to run a 5 day course on QGIS, PostgreSQL and
PostGIS. The course is structured with content to suit novice, intermediate and advanced users alike and has many
exercises complete with annotated answers throughout the text.
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1.1.3 License

@050

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti and
is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the
usage guidelines are as follows:

You may not represent this work as your own work, or remove any authorship text or credits from this work.

You may not redistribute this work under more restrictive permissions than those under which it was provided
to you.

If you add a substantive portion to the work and contribute it back to the project (at least one complete module)
you may add your name to the end of the authors list for this document (which will appear on the front page)

If you contribute minor changes and corrections you may add yourself to the contributors list below.

If you translate this document in its entirety, you may add your name to the authors list in the form “Translated
by Joe Bloggs”.

If you sponsor a module or lesson, you may request the author to include an acknowledgement in the beginning
of each lesson contributed, e.g.:

Note:

This lesson was sponsored by MegaCorp.

If you are unsure about what you may do under this license, please contact us at office@linfiniti.com and we
will advise you if what you intend doing is acceptable.

If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

You may not commercialise this work, except with the expressed permission of the authors. To be clear, by
commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling
content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project.
You may (and we encourage you to do so) use this work as a text book when conducting training courses, even
if the course itself is commercial in nature. In other words, you are welcome to make money by running a
training course that uses this work as a text book, but you may not profit off the sales of the book itself - all
such profits should be contributed back to QGIS.

1.1.4 Sponsoring Chapters

This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add
new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial
service, with the understanding that all such works produced should become part of the core content and be published
under the same license.

Chapter 1. Course Introduction
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1.1.5 Authors

* Riidiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.

* Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts. Tim also authored the custom sphinx theme used for this manual.

* Horst Diister (horst.duester@kappasys.ch ) - Horst co-authored the PostgreSQL and PostGIS parts

* Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Individual Contributors

Your name here!

1.1.7 Sponsors

e Cape Peninsula University of Technology

1.1.8 Source files and Issue reports

The source of this document is available at GitHub QGIS Documentation repository. Consult GitHub.com for in-
structions on how to use the git version control system.

Despite our efforts, you could find some errors or miss some information while following this training. Please report
them at https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Latest Version

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://docs.qgis.org).

Note: The documentation website contains links to both online and PDF versions of the Training manual and other
parts of the QGIS documentation.

1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Warning: This course includes instructions on adding, deleting and altering GIS datasets. We have provided
training datasets for this purpose. Before using the techniques described here on your own data, always ensure
you have proper backups!
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1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks » like » this directs you through menus.

This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

\ Basic

In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

/ Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.

= Advanced

In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.
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1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
» Streets and Places datasets from OpenStreetMap (https://www.openstreetmap.org/)
 Property boundaries (urban and rural), water bodies from NGI (https://ngi.dalrrd.gov.za/)
¢ SRTM DEM from the CGIAR-CGI (http://srtm.csi.cgiar.org/)

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are
provided in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the Preparing Exercise Data appendix.
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CHAPTER
TWO

MODULE: CREATING AND EXPLORING A BASIC MAP

In this module, you will create a basic map which will be used later as a basis for further demonstrations of QGIS

functionality.

2.1 Lesson: An Overview of the Interface

We will explore the QGIS user interface so that you are familiar with the menus, toolbars, map canvas and layers list

that form the basic structure of the interface.

The goal for this lesson: To understand the basics of the QGIS user interface.

211 \ Try Yourself: The Basics

*Basic Map - QGIS 0c62abed96 [tm]

Project Edit View Layer Settings Plugins Vet
BRERRR OH*seesn R 5 ]
[u] =qEANERTY @ B

Layers B®
3T E 3= g=)
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v/ roads o

SNSBH S

Layers | Browser a
O
Type to locate (Ctrl+K I]\egendenmesmmoved Coordinate|20.3420,-33.9989 | ¥ Scale 1:32869 |~ | @ Magnifier| 100% | Rotation |0.0°

2| v/Render @ EPSGia326 @

The elements identified in the figure above are:
1. Layers List / Browser Panel
2. Toolbars

3. Map canvas
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4. Status bar
5. Side Toolbar

6. Locator bar

\ The Layers List

In the Layers list, you can see a list, at any time, of all the layers available to you.

Expanding collapsed items (by clicking the arrow or plus symbol beside them) will provide you with more information
on the layer’s current appearance.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference
system and the complete path of the location on your device.

Right-clicking on a layer will give you a menu with lots of extra options. You will be using some of them before long,
so take a look around!

Note: A vector layer is a dataset, usually of a specific kind of object, such as roads, trees, etc. A vector layer can
consist of either points, lines or polygons.

\ The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or Maplnfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WEFS connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the * Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,

right click on it and click on Add as a Favorite. Youshould then be able to see your folder in the Favorites
item.

Tip: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite. .. to set another name.

\ Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar
allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools
you use most often, adding or removing toolbars as necessary via the View » Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

8 Chapter 2. Module: Creating and Exploring a Basic Map
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\ The Map Canvas
This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the

visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

\ The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

\ The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But
remember that you can move all the toolbars wherever it is more comfortable for you.

\ The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Tip: With the shortcut Ct r1+K you can easily access the bar.

2.1.2 \ Try Yourself 1

Try to identify the four elements listed above on your own screen, without referring to the diagram above. See if you
can identify their names and functions. You will become more familiar with these elements as you use them in the
coming days.

Answer

Refer back to the image showing the interface layout and check that you remember the names and functions of the
screen elements.

21.3 \ Try Yourself 2

Try to find each of these tools on your screen. What is their purpose?

=]
1. =5

2 B
3. B

4. BRena’er

2.1. Lesson: An Overview of the Interface 9
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Note: If any of these tools is not visible on the screen, try enabling some toolbars that are currently hidden. Also
keep in mind that if there isn’t enough space on the screen, a toolbar may be shortened by hiding some of its tools.
You can see the hidden tools by clicking on the double right arrow button in any such collapsed toolbar. You can see
a tooltip with the name of any tool by holding your mouse over the tool for a while.

Answer
1. Save as
2. Zoom to layer(s)
3. Invert selection
4. Rendering on/off
5

. Measure line

2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.

2.2 Lesson: Adding your first layers

We will start the application, and create a basic map to use for examples and exercises.

The goal for this lesson: To get started with an example map.

Note: Before starting this exercise, QGIS must be installed on your computer. Also, you should have downloaded
the sample data to use.

Launch QGIS from its desktop shortcut, menu item, etc., depending on how you configured its installation.

Note: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup, the
screens you encounter may well appear somewhat different. However, all the same buttons will still be available, and
the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this course.

Let’s get started right away!

2.2.1 \ Follow Along: Prepare a map

1. Open QGIS. You will have a new, blank map.
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2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We'll use
it to load our dataset: click the ‘! Open Data Source Manager o,

If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View » Toolbars menu.

Untitled Project - QGIS [new]
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
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- ¢ Vector

Raster
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® wes
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© ows

» 6 Home
Y/ =)
2% Mesh
L] » @ GeoPackage

¢ Delimited Text / spatiaLite

@ ArcGisMapServer @ Postals
@ ArcGisFeatureserver S Geopackage » mssqL
st GeoNode @ pB2
#,, SpatiaLite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL & wes
v WFS
» © ows
ArcGisMapserver
& ArcGisFeatureserver
i GeoNode
Layers & WA virtual Layer *
“a=sv e -
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&3 ArcGis Map Server
ArCGIS Feature
J# server
4 GeoNode
Q Type to locate (Ctrl+K) Ready Coordinate ¥ scle 11 ~| @ Magnifier | 100% | Rotation |00° 2|V Render @ EPSG4326 @

3. Load the protected_areas. shp vector dataset:

1. Click on the Vector tab.

2. Enable the - ® File source type.

3. Press the ... button next to Vector Dataset(s).
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4. Select the exercise_data/shapefile/protected_areas. shp file in your training direc-
tory.

5. Click Open. You will see the original dialog, with the file path filled in.

Data Source Manager | Vector

B Browser Source Type
\/ Vector

* Raster

(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.

, Encoding System -
e F Mesh

_. Source
* Delimited Text

\lﬂ GeoPack Vector Dataset(s) 'exercise_data/shapefile/protected areas.shp

4 GeoPackage

;f:_ Spatialite
* PostgreSQL
* MS5QL

082, DB2

m Virtual Layer

!Ea WMS/WMTS
5@; WCs
g WFS
ArcGIS Map
server

ArcGIS Feature
Server @Help < Add * Close

6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.
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*Untitled Project - QGIS [new] =
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Congratulations! You now have a basic map. Now would be a good time to save your work.

=]
1. Click on the Save As button: =54

2. Save the map under a solut ion folder next to exercise_data and call it basic_map.qgz.

222 \ Try Yourself

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Answer

In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you
can identify by its color in the left panel (your colors may be different from the ones in Fig. 2.1 below):

2.2. Lesson: Adding your first layers 13
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basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Fig. 2.1: A basic map

223 \ Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a
database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use
of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI
Shapefile format (e.g. the protected_areas.shp dataset you loaded earlier), a single GeoPackage file can
contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without
spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the ‘5 Open Data Source Manager ¢,

2. On the left click on the @ GeoPackage tab.

3. Click on the New button and browse to the training_data.gpkg file in the exercise_data folder
you downloaded before.

4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the Connect button. In the central part of the window you should now see the list of all the layers
contained in the GeoPackage file.

2. Select the roads layer and click on the Add button.
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Data Source Manager | GeoPackage

W srowser Connections
- g Vector training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg v
4 Raster New Remove
X1/
et W Table - Type Geometry column Sql
- ~ /media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg
4 Delimited Text buildings & MultiPolygon geom
% GeoPackage roads ' LineString  geem
i’:_ SpatiaLite
+ PostgreSQL
* MSSQL
082, pB2
m Virtual Layer
ﬁ WMS/WMTS
L5 wes
e WFS [ )

=
Also list tables with no geometry

.)‘4'- ArcGIS Map Server

ArcGIS Feature
Server

& GeoNode @Help Set Filter «/ Add % Close

Search options

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

224 \ Follow Along: Loading vector data from a SpatiaLite Database
with the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection —> Enable it —> Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.
1. Click the g icon to open the Data Source Manager window.

2. Click on the B Browser tab.

3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs
in the left. These allow quick access to connected databases or folders.

For example, click on the drop-down icon next to the 0 GeoPackage entry.  Youlll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).

4. Right-click the lﬁ SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the 1anduse.sglite file and click Open.
Notice that a @ landuse.sqglite entry has been added under the SpatiaLite one.

6. Expand the @ landuse.sqlite entry.

2.2. Lesson: Adding your first layers 15
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7. Double-click the ' landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Data Source Manager | Browser

_:_.- Browser Browser

QESTHO

B Vector

- Favorites
» [¥% Project Home
Raster

L » [a] Home
A% Mesh ey

® ~ @ GeoPackage

o Delimited Text ~ © training_data.gpkg
_ = buildings

if GeoPackage /" roads

~ / Spatialite

i"'; SpatiaLite * = landuse.sqlite

- PostgreSQL @ PostGls
» mssqQL
e MSSQL £ B2
@ WMS/WMTS
DB%" D82 v &8 XYZ Tiles
WA . ¥ OpenStreetMap
Lﬁ_ virtual Layer @ wes
s @ WFS
\ﬁ“_ WMS/WMTS © ows
—:@:—‘_ WCS @ ArcGisMapServer
&7 ArcGisFeatureServer
.y WFS # GeoNode

%74 ArCGIS Map Server

ArcGIS Feature
* Server

» GeoMNode

Tip: Enable the Browser panel in View » Panels » and use it to add your data. It’s a handy shortcut for the Data
Source Manager » Browser tab, with the same functionality.

Note: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it
remembers which layers you loaded into your map.

225 / Try Yourself Load More Vector Data

Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

* buildings

* water

Answer
Your map should have seven layers:

* protected_areas
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* places

* rivers

* roads

* landuse

* buildings (taken from training_data.gpkg) and

e water (taken from exercise_data/shapefile).

2.2.6 Follow Along: Reordering the Layers

The layers in your Layers list are drawn on the map in a certain order. The layer at the bottom of the list is drawn
first, and the layer at the top is drawn last. By changing the order that they are shown on the list, you can change the
order they are drawn in.

Note: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel. We
will however not discuss this feature yet.

The order in which the layers have been loaded into the map is probably not logical at this stage. It’s possible that the
road layer is completely hidden because other layers are on top of it.

For example, this layer order...

Layers (=]ES]
o @ ® T & - & O

v [ water

v! [[] buildings

v/ [ landuse

v/ — roads

v — rivers

v| * places

v [] protected_areas

... would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
To resolve this problem:
1. Click and drag on a layer in the Layers list.

2. Reorder them to look like this:

2.2. Lesson: Adding your first layers 17



QGIS Training Manual

basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help
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You'll see that the map now makes more sense visually, with roads and buildings appearing above the land use regions.

2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you're familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navigating the Map Canvas

This section will focus on basic QGIS navigation tools used to navigate within the Map Canvas. These tools will allow
you to visually explore the layers at different scales.

The goal for this lesson: Learn how to use Pan and Zoom tools within QGIS and learn about map scale.

2.3.1 \ Follow Along: Basic Navigation Tools

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.

1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen pro—
tected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Fig. 2.2 below (colors do not matter):
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Fig. 2.2: Protected areas, roads and buildings added

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the @ Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the 4*+’ Zoom In bystton,
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.

4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Fig. 2.3).

2.3. Lesson: Navigating the Map Canvas 19
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Fig. 2.3: Zoom in

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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6. To zoom out, select the }9 Zoom Out byytton and perform the same action as you did for zooming in.

As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on ;a Zoom Last hytton to go to your previous view.

2. Click on }a Zoom Next bytton to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the ﬂ Zoom Full Extent tyyon,

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the
Map Canvas is to the actual object in the real world.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale textfield.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you
typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

£
1:1000000 =

1:500000
1:250000
1:100000
1:50000
1:10000
1:5000
1:2500
1:1000 '~
b Scale|1:50000 v

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Symbology

The symbology of a layer is its visual appearance on the map. The basic strength of GIS over other ways of repre-
senting data with spatial aspects is that with GIS, you have a dynamic visual representation of the data you’re working
with.

Therefore, the visual appearance of the map (which depends on the symbology of the individual layers) is very
important. The end user of the maps you produce will need to be able to easily see what the map represents. Equally
as important, you need to be able to explore the data as you're working with it, and good symbology helps a lot.

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s essential for you to use a
GIS properly and produce maps and information that people will be able to use.

The goal for this lesson: To be able to create any symbology you want for any vector layer.
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2441 \ Follow Along: Changing Colors

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the landuse layer.
1. Right-click on the landuse layer in the layers list.

2. Select the menu item Properties... in the menu that appears.

Note: By default, you can also access a layer’s properties by double-clicking on the layer in the Layers list.

Tip: The @( button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the d Symbology tab:

Layer Properties - landuse | Symbology
[ Zsinglesymbol -]

@ information eIk

2 simple Fill
A=y 5 .
AN Source
& symbology
€ Labels
€O Masks Unit | Millimeters -]
. Opacity 1/1000% |2
Diagrams ~
Color | H
W# 3D View
E Fields
E Attributes Form | @ Favorites - | &
Joins
ﬁ Auxiliary Storage -I -
@ Actions , ) . . "
gradient gray 3 fill hashed black / hashed black,  hashed black X outline blue outline green outline red
. plasma
- Display
: r
.‘ Rendermg : @ - - -
i L
Variables
. outline xpattern pattern dot pattern zelda simple blue fill  simple greenfill  simple red fill
a Metadata black
" Dependencies (B = |save Symbol... || Advanced ~|
Legend » Layer Rendering
[ qais server .| @Help || style - | «/Apply || % cancel |’ </ OK ]

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Choose a gray color and click OK.

6. Click OK again in the Layer Properties window, and you will see the color change being applied to the layer.
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2.4.2 \ Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solution

 Verify that the colors are changing as you expect them to change.

« It is enough to select the water layer in the legend and then click on the (\{ Open the Layer Styling panel by top,
Change the color to one that fits the water layer.

symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEBRREY QAL ARPPLALMLBLORC 6 K-N-EHEI =0
BEV LR P/ BRR-Z T DB =W HAERT R A

Layers B Layer styling (=[]

<8l TE-B »

(- water -

* & | = single symbol -
] ] simple fill
v|[] water
0
v [] landuse
) | aflWw
unit | Millimeter | =
Opacity = | 100.0% =
Color W
. Favorites a|-| &

» Layer Rendering
P V| Live update | « Apply

Layers | Browser

L Type to locate (Ctrl+K) Coordinate | 20.5265-33.9850 | Scale 1:50008 ~ | @ Magnifier 100% < | Rotation |0.0° +| v Render @ EPsc4326 @

If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer
by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

243 \ Follow Along: Changing Symbol Structure
This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.
1. Open the Layer Properties window for the landuse layer.
Under the (\{ Symbology tab, you will see the same kind of dialog as before. This time, however, you’re
doing more than just quickly changing the color.
2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.
3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.

4. Change this to No Pen.

24 Chapter 2. Module: Creating and Exploring a Basic Map



QGIS Training Manual

Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|

Simple Fill
N :
AN Source e
Q2]
ﬂ' symbology
€3 Labels
5 Masks symbol layer type| Simple Fill v |
: i .
" Diagrams Fill color | H =
Fill skyl Solid v
Wf 3D View syle | -| =
stroke color | (NN - =,
B Fielas B
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
o] Joinstyle | T Bevel M=
ﬂ Auxiliary Storage % | 0,000000 |:
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
q. Rendering
P Layer Rendering
Variables _| @nelp || style - | «/Apply || % cancel |[ < oK ]

5. Click OK.

Now the landuse layer won’t have any lines between areas.

24.4 \ Try Yourself

* Change the water layer’s symbology again so that it has a darker blue outline.

» Change the rivers layer’s symbology to a sensible representation of waterways.

Remember: you can use the d Open the Layer Styling panel by;tton and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Answer

Your map should now look like this:
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symbology - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
0 B (e, HPPLARRINLS &6 N-N-GEHE I - [T
REV.AR J/BVER-ZT BB =4 HEB3%T R 2 « K

@® Layer Styling =[]
® /" rivers -
& = Single symbol -
v b 5 — Simple line
areas D
8 ' K
= B
Q & O allw
{
= e unit  Millimeter x|~
N Opacity _1/100.0 % =
’ color | NN
Wwidth | 0.36000 ERES
<. Favorites a |- a
» Layer Rendering
Layers | Browser b e V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate  20.3963-34.0335 | 9§  Scale | 1:51337 ~ | @ Maagnifier| 100% 2| Rotation |0.0° || Render ¢ EPSG:4326 @

If you are a Beginner-level user, you may stop here.
 Use the method above to change the colors and styles for all the remaining layers.
» Try using natural colors for the objects. For example, a road should not be red or blue, but can be gray or black.

* Also feel free to experiment with different Fill style and Stroke style settings for the polygons.

symbology - QGIS
Project Edit View Layer Settings Plugins WVector Raster Database Web Help

NEEBRREY NE,sNPPAAGBEIS 66 -0 - B8 e -
BV A y/BRER-ZTd<8 B o g e E o on = @A x

Layers ® Layer Styling ®
|0 e T & -8 » - 7 buildings -
Vi 8 places = Single symbol -
v/ — roads nd
7 — rteere __F
v! [l buildings W simple fill
v| [ | water | " .
v || protected_areas , ML ¢ i "l
v landuse
’, 7 & ol[a|[¥
<4 =
i unit  Millimeter |~
Opacity _1/100.0 % -
Color I
. Favorites a|-| &
P Layer Rendering
Layers | Browser / LIS V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate| 20.5355-33.9815 |5 Scale 1:53664 ~ | @ Magnifier 100% ~| Rotation |0.0° +| v Render @ Epsc:4326 @
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245 / Follow Along: Scale-Based Visibility

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may
have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset
at inappropriate scales.

In our case, we may decide to hide the buildings from view at small scales. This map, for example. ..

symbology - QGIS 3

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEEREBRY Q2L HPPLAlBOR Q6 N-R-EHE D &-6 -

5l @m = 7 o A abgl ‘abe| (abgl ‘abel ‘abg %
V.2 WM y/BOR-Z2T>%5 6 mgEeyuggs @ 2 B %%
Layers (2]

o @l e T &~

v| * places

v! — roads

v — rivers

v ; buildings

V| [ | water

v protected

v landuse

|
/
£

Layers | Browser

Q Type to locate (Ctrl+K) sordinal| 207122339589 |% zal|1:150104 |~ | @ agnifi 100% | otatic |0.0° <| ¥/ Render & EPSG:4326 @

... is not very useful. The buildings are hard to distinguish at that scale.
To enable scale-based rendering:

1. Open the Layer Properties dialog for the buildings layer.

2. Activate the f Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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Layer Properties - buildings | Rendering >

v |v| Scale Dependent Visibility

Minimum (exclusive) Maximum (inclusive)
4= [1:10000 - |[&| P o - ||m

v Simplify Geometry

"}’ Information

" Source

%" symbology
Note: Feature simplification may speed up rendering but can result in rendering inconsistencies
€3 Labels S . . - e N -
Simplification threshold (higher values result in more simplification) 1,00 pixels
€D Masks simplification algorithm Distance ~
Diagrams
‘4; 3D View Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -
E Fields Force layer to render as a raster (may result in smaller export file sizes)
E Attributes Form Refresh layer at interval (seconds)

, Refresh layer on notification
Joins

ﬁ Auxiliary Storage
{;'.-Q Actions
, Display

@’ Rendering

5. Click OK.

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and reappears.

Note: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a window:

Ye

2.4.6 / Follow Along: Adding Symbol Layers

Now that you know how to change simple symbology for layers, the next step is to create more complex symbology.
QGIS allows you to do this using symbol layers.

1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

In this example, the current symbol has no outline (i.e., it uses the No Pen border style).
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f}' Information

‘}S,‘_- Source

ﬂ’ symbology

€3 Labels

B Masks

. Diagrams

Wf 3D View
B Fielas

E Attributes Form

Joins

ﬂ Auxiliary Storage
@ Actions
. Display

& f Rendering

Variables

Layer Properties - landuse | Symbology

| = Single symbol -]

v [ Fill | & |
Simple Fill —
el
symbol layer type| Simple Fill |
Fillcolor | M |;| LEE
Fill style [ solid - &
stroke color | (. - .
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
Stroke style | No Pen K=t
Join style |a Bevel - | =i
X | 0,000000 E
Offset ' Millimeters - |
y  0,000000 2]

v| Enable symbol layer =, Draw effects

P Layer Rendering
@Help || style -|

| Japply || ®cancel || JoK |

2. Select the Fill level in the tree and click the Ifl-l-ll:| Add symbol layer 1y,tton, The dialog will change to look something
like this, with a new symbol layer added:
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Layer Properties - landuse | Symbology >

= Single symbol =
"’;’ Information ~ H Fill
Simple Fill =l
33 source . [X simple Fill .
' =E
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj,/ Rendering
» Layer Rendering
e dblee @Help Style -~ « Apply || % cancel «/ OK

-

It may appear somewhat different in color, for example, but you’re going to change that anyway.

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol.
Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Note: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or raster)
that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This course
will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to prevent
confusion.

With the new Simple Fill symbol layer selected:
1. Set the border style to No Pen, as before.

2. Change the fill style to something other than Solid or No brush. For example:
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Layer Properties - landuse | Symbology

- |

| = single symbol

fi' Information ~ [ Fill |§|

Simple Fill — =
‘:{:\\ Source [T simple Fill :i: :l:
: Q|| a
& symbology -
€= Labels
€D Masks symbol layer type| Simple Fill - |
: i (.
S Fill color | H <
Fill skyl i cross -
WF 3D View term | _| =
stroke color | (. - <.
E Fields -
Stroke width | 0,260000 @ || Millimeters  ~ | &,
E Attributes Form
Stroke style | No Pen - &
Joins Joinstyle | T Bevel - &
E’. Auxiliary Storage % | 0.000000 |:
Offset | Millimeters - |
L Actions y |0,000000 S ——
® oisplay v| Enable symbol layer =, Draw effects
&  Rendering
» Layer Rendering
Variables _| @Help || style ~| | «/Apply || % cancel H «/ OK ]

3. Click OK.

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

O | o |
i simple Fill
1T simple Fill
] simple Fill

It’s fun! But it probably has too many colors to use in a real map...

247 / Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using the
methods above.

Answer

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on the
map.

Here’s an example:
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symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DoBRREEY Ve, HPRLLALBMNR & N-A-EHEE -
BV AW J/BRR-ZT<2HBHoe T2QE =2 - R &4 B &

Layers
« @ ® T & -8 &L =

* places

— roads

— rivers

[7] buildings

|:| water

[] protected_areas

[ landuse

Layers & Browser
[ 2 Type to locate (ctrl+K) | 1| 2045020-3401345 | 2| 1:5000

EEREXS |2| v Render @ Epsgiezzs @

|vl & rf100%

2438 / Follow Along: Ordering Symbol Levels

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1 . 5 and a black color.
3. Give the new, uppermost layer a thickness of 0. 8 and a white color.

You'll notice that this happens:
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Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.

To change the order of the symbol layers:
1. Select the topmost Line layer in the symbol layers tree.

2. Click Advanced w Symbol levels... in the bottom right-hand corner of the window.
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Layer Properties - roads | Symbology B

Q = single symbol =
@ information %
simple line
33 source == Simple line
& symbology
€€ Labels
Unit Millimeters >
B Masks .
Opacity _11100,0% v
", Disgrams Color | -
@& .
3D View
alg width | 1,50000 =RES
E Fields
. (73
E Attributes Form . Favorites a|~| 8
Joins
E_'i Augxiliary Storage
{;'.-® Actions dash black dash blue dash green dash red
- Display Sl v
i Save Symbol...
4 Rendering Symboly evels...

_ b Layer Rendering v| Clip Features to Canvas Extent
Variables _ | @Help Style ~ « Apply || % Cancel < OK

This will open a dialog like this:

symbol Levels x

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help % Cancel

3. Check oA Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. O is the bottom layer.
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In our case, we just want to activate the option, like this:

Symbol Levels

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer 0 Layer 1
= () 1

% cancel |[_Jok_|

This will render the white line above the thick black line borders:
4. Click OK twice to return to the map.

The map will now look like this:

N\

When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again

in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.
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Save your style in the solution/styles/better_roads.qgml folder. You can load a previously saved style
at any time by clicking the Load Style... button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

24.9 / Try Yourself

Change the appearance of the roads layer again.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced » Symbol levels... dialog.

Answer

To make the required symbol, you need three symbol layers:

Layer Properties - roads (triple_levels) | Symbology

| single symbol
@ information | tine __ ________________

— Simple line
:{:\1_- Source simple line
== Simple line
& symbology
€2 Labels —
| | ollallw
Diagrams
~ unit | Millimeter - |
N 3D View s 1/1000% %/
E SourceFields eCoal ]
Attributes <
Form width | 2.10000 EKES
Joins
L Auxiliary | 2 Favorites ~| 8
&1 storage .
@ Actions
© [EEE T PRI PP T —
- Display
‘ Rendering dash black dash blue dash green dashred effect emboss effect neon
Varisbles Ell= |save Symbol| | Advanced ~|
ak Metadata
P Layer Rendering
T Dependencies .| @Help || style - | JApply || ®cancel || ok |

The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally
another thinner solid black line.
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If your symbol layers resemble the above but you’re not getting the result you want:

1. Check that your symbol levels look something like this:

symbol Levels

Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1 Layer
= L] 1 — 2

1] v

 cancet | [_J0_|

2. Now your map should look like this:

2410 a Try Yourself

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered classi-
fication yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.qgml provided in exercise_data/styles to the

layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.
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3. Zoom in to the Swellendam area.

4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:

e\ Vs
ot Vo, (
@&%ﬁ@ ﬂ

Answer

1. Adjust your symbol levels to these values:

symbol Levels X

v Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1
| Trunk [ [ 3
—|Tertiary - 2
=|Unclassified =0 1

@Help # Cancel

1. Experiment with different values to get different results.

2. Open your original map again before continuing with the next exercise.
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24.11 / Follow Along: Symbol layer types

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we've been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Point Symbol Layer Types

1. Uncheck all the layers except for places.

2. Change the symbol properties for the places layer:

Layer Properties - places | Symbology
| = single symbol ]

'ri Information

® Simple marker

A3 source

.Q’ symbology

€3 Labels

€D Masks Unit | Millimeters -
Opacity 1100,0% </

I
Size | 2,00000 BE="
E Fields Rotation | 0,00 ° 2| €&

E Attributes Form | Q. Favorites a@ v| H4

- .
. Diagrams

Color |

N7 3D View

Joins

I'ﬁ Auxiliary Storage ® O @ O O %

@ Actions

- Display shadow

dot black dot white dot blue dot green dot red effect drop

4 Rendering B @ ®

Variables

N shield disability topo hospital  topo pop capital
a Metadata

ﬁ Dependencies |_| = |save Symbol... | |Advanced - |

» Layer Rendering
.| @Help || style -  Japply || Xcancel || JoOK |

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator

Mask

€3 Labels .
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3. 00 and a Stroke
width of 0. 5.

Line Symbol Layer Types

To see the various options available for line data:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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"i Information

-?& Source

Q’ Symbology

€= Labels

B Masks

: Diagrams

N7 3D View

E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

&  Rendering

Variables
E Metadata

ﬁ Dependencies

| = single symbol

[ @rep | syle -

Layer Properties - roads | Symbology

v — Line

Arrow
Geometry generator
Hashed line

Marker line &
symbol layer type| Simple line

Color . ] E| L=
Stroke width | 0,260000 @ ||| Milimeters  ~| &,
Offset 10,000000 2| Millimeters  ~| &
stroke style | ——Solid Line K=
Join style | B Bevel - &
Cap style | B square - e
Use custom dash pattern
| Millimeters - g

v| Enable symbol layer 4=, Draw effects

P Layer Rendering

 /Apply || %cancel || JoK |

2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:
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Layer Properties - roads | Symbology
| = single symbol

"i Information ~ -+ Line |E|
* . - Marker line

;{s} Source v - Marker

Q/ Symbology

""""" jla

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 0,500000 |$| | Millimeters ~| &
.." 3D View Fill color | E| (=8
B s stroke color | MM | <,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
& Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AT D000AAK T @++X | > b
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Select the Marker line layer and change the interval to 1.00:
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Layer Properties - roads | Symbology

Q = Single symbol -

%) Information ~ . Line e

3

"W Source ~ + Marker =
- simple marker L2

Q’ Symbology

€3 Labels

B Masks symbol layer type| Marker line -

: Diagrams Marker placement =,

.‘.’, 3D View (s with interval 1,000000 < | | Millimeters ~ &

E Fields ' on every vertex

() on last vertex only

E Attributes Form ) )
! on first vertex only

Joins (! on central poink
s’i Augxiliary Storage ) on central point of segments

() on every curve point

{;'.-® Actions
- Display

Q." Rendering

Offset along line 0,000000 Millimeters ~| &

v| Rotate marker to Follow line direction

Average angle over | 4,000000 < | Millimeters ~| &
Variables Line offset 0,000000 2 |Millimeters  ~ | &
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ensure that the symbol levels are correct (via the Advanced w Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction
along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you
prefer, you can change the symbol layer in question back to the way it was before.

Polygon Symbol Layer Types

To see the various options available for polygon data:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigate what the different options on the list can do.
3. Choose one of them that you find suitable.

4. If in doubt, use the Point pattern fill with the following options:
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|
~ °  Point pattern fill
v © Marker

° Q]3]

- |

-?& Source

Q’ Symbology

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
B s stroke color | (N | =,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
4" Rendering \VCenter K=
Variables Anchor point 'HCenter aK=E
 srctad
B mecadoro OCO00CAANXTO@F+F X | DD
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

a cooo Point pattern Fill
"W Source o000 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal |4,000000 <| | Millimeters K =R
N7 3D View [ | <] |
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
L Offset
5" Augxiliary Storage
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
g. Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. Add a new symbol layer with a normal Simple fill.
6. Make it the same light blue with a darker blue border.

7. Move it underneath the point pattern symbol layer with the Move down button:
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape
and distance of the individual dots that make up the texture.

2412 / Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Answer

Here are examples of the symbol structure:

Layer Properties - protected_areas | Symbology
| = single symbol -

"rf Information ~ . Fill

Marker line Nhkddk
;-'o_';_\ Source ~ 4 Marker : :
+ Simple marker ) >
w' symbology simple Fill ayvvvy
€2 Labels — — — — —
1®||=|8laallY]
. Diagrams
symbol layer type| Outline: Marker line v| =
u# 3D View
Marker placement <,
E Source Fields ® with | | I la
®) with interval |3.000000 = Millimeter -
Attributes
Form ) on every vertex
Joins ) on last vertex only
&% Auxiliary ) on first vertex only
L Storage )
: _! on central point
& Actions ]
- ! on every curve point
Display y | PP
Offset along line | 0.000000 || Millimeter -~ &
& Rendering ¥| Rotate marker
Variables Line offset |0.000000 /| Millimeter K=
!h Metadata T I
P Layer Rendering
™ Dependencies _| @Help | stle -| | «/Apply || ®cancel |’ «/ OK ]
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'ff Information

Layer Properties - protected_areas | Symbology

| 2 single symbol -

=
~ _ . Fill

¥ i 4 Marker line ey

;{0} Source * 4+ Marker - -

1 £
& symbology simple Fill avrvyy
€3 Labels — ——

1E|[=|8]|3]| a]l¥
'I Diagrams

Symbol layer type| Simple marker v| =
W 3D View

Size |2.200000 2| | Millimeter -~ e

E Source Fields .

: i ]
Attributes AlLe | l;| &
— Stroke color | H (=R
Joins ~
o stroke style | ——Solid Line aK=E

=~ Auxiliary

& B storage Stroke width | 0.200000 @ ||| Millimeter K =N
@ Actions Join style | B Bevel - a
. Display Rotation |0.00° |:| <
o o x | 0.000000 s

& Rendering Offset | | Millimeter aK=E

Variables y 0.000000 |'|
| vcenter K =

ah Metadata

P Layer Rendering

™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

2.4.13 & Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol
depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology
itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.

Moreover, you have all the styling options to change the appearance of the resulting symbol.

Let’s give it a try!

1. Select the water layer.

2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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(] Centroid Fill
| Z single symbol

G‘ Information

Geometry ge'?eratcr
Gradient fill

Line pattern Fill
Point pattern Fill
Random marker Fill 3

-?& Source

Q’ Symbology

Raster image Fill
€3 Labels SVG Fill
Shapeburst Fill

B Masks symbol layer typ
simple Fill
-
, Diagrams Fill color | Outline: Arrow
.r' 3D View Fill style | Outline: Hashed line
- | Outline: Marker line
i Stroke color
E Fields Outline: simple line
E Attributes Form Stroke width | 0,260000 @ [7[|Millimeters ~ T &
. Stroke style | ——Solid Line -~ &
Joins
. Joinstyle | T Bevel -~ &
E" Augxiliary Storage -
x |0,000000 S —
1B Actions Offset - | Millimeters ~|
y | 0,000000 2] R
- Display
&  Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

E Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

centroid ($geometry)
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information ~ @ Fill |E|

an
W Source ~ @ Marker e
® simple marker |E| |ﬂ|

Q’ Symbology
€3 Labels
B Masks Symbol layer type| Geometry generator v|
: Diagrams Geometry type | " Point / MultiPaint - |
ﬁ 3D View centroid{$geometry) |E|
E Fields
E Attributes Form

Joins
ﬁ Augxiliary Storage
@ Actions
- Display
&  Rendering

Variables
E Metadata 4 L

v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ oK ]

5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a spatial
operation within the layer symbology itself, isn’t that amazing?
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°
°
°
° e
.
°
Layers | Brow
Type to locate (Ctrl+K Coordinate| 20.4963.-33.9835 |® Scale|1:34265 |~ @ Magnifier| 100% 2| Rotation |0.0° %V Render @ EPSG:4326 @

With the Geometry generator symbology you can really go over the edge of normal symbology.

mm= Try Yourself
Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator
one.
Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
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Answer

1. Click on the "--II:I-II:I button to add another Symbol level.

2. Move the new symbol at the bottom of the list clicking the v button.
3. Choose a good color to fill the water polygons.
4. Click on Marker of the Geometry generator symbology and change the circle with another shape as your wish.

5. Try experimenting other options to get more useful results.

2414 === Follow Along: Creating a Custom SVG Fill

Note: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
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You should find this familiar if you have used other vector image editing programs, like Corel.

First, we’ll change the canvas to a size appropriate for a small texture.

Change the Units to px.

NS A »N

Select the Circle tool:

Close the dialog when you are done.

Change the Width and Height to 100.

Click on the menu item File » Document Properties. This will give you the Document Properties dialog.

Click on the menu item View » Zoom » Page to see the page you are working with.
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8. Click and drag on the page to draw an ellipse. To make the ellipse turn into a circle, hold the Ct r1 button
while you're drawing it.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering,
such as:

1. Change the Fill color to a somehow pale grey-blue,
2. Assign to the border a darker color in Stroke paint tab,

3. And reduce the border thickness under Stroke style tab.
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10. Draw a line using the Pencil tool:

1. Click once to start the line. Hold Ctr1 to make it snap to increments of 15 degrees.

2. Move the pointer horizontally and place a point with a simple click.

3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5

. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as
necessary, so that you end up with a symbol like this one:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is in,
under exercise_data/symbols, as SVG file.

In QGIS:
1. Open the Layer Properties for the 1anduse layer.
2. In the ‘Q( Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill™™
shown below.
3. Click the ... button and then Select File... to select your SVG image.

It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,
units. ..).
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Layer Properties - landuse | Symbology

| = single symbol

%) Information ~ [ Fill | |
— 4 SVG fill
-?& Source = :J:i v — Line o
7\ r‘ — simple line |E| |Q|
Q’ Symbology E —
€3 Labels
B Masks symbol layer type SVG fill -
: Diagrams Texture width | 10,000000 |:| | Millimeters - &
.r' 3D View Fill color (=8
E Fields Stroke color =8
BB Attributes Form Stroke width | || Millimeters  ~| &
: Rotation 0,00° i &
Joins
SVG Groups SVG symbols
E" Auxiliary Storage ~ [ App Symbols - - . . 252 =
& _ [ accommodation - ..
g Actions ] amenity oy e
: [ arrows i S|e &y x
- Display L

[J backgrounds
[ components

&  Rendering

[ crosses o :
Variables [] emergency |0 ' _ '||
[ entertainment we llwe I
{ Metadata [ food h &
a [ gpsicons X : S Y o | ﬂ%
ﬁ Dependencies [ health
[J landmark = A\ O ‘#’ ’(:}‘ [E— m A =
"~ Legend A
s *nts/GIS/QGIS/TrainingManual/exercise_data/symbols/landuse_symbol.svg & ||_|t| =i
& qais server
v| Enable symbol layer <, Draw effects

ﬂ Digitizing

» Layer Rendering
| @Help || style -  Japply | %cancel |[ ok |

Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a texture
like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set in the
layer properties a bigger Texture width.
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2.4.15 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not
only can you see what’s happening, it’s even nice to look at!

2.4.16 Further Reading

Examples of Beautiful Maps

2.4.17 What's Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to
someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to?
What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain
how to represent this data on your map.

Note: Did you remember to save your map recently?
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CHAPTER
THREE

MODULE: CLASSIFYING VECTOR DATA

Classifying vector data allows you to assign different symbols to features (different objects in the same layer), de-
pending on their attributes. This allows someone who uses the map to easily see the attributes of various features.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location
and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while
their other properties are included as attributes (often presented as a table in QGIS).

Up to now, none of the changes we have made to the map have been influenced by the objects that are being shown.
In other words, all the land use areas look alike, and all the roads look alike. When looking at the map, the viewers
don’t know anything about the roads they are seeing; only that there is a road of a certain shape in a certain area.

But the whole strength of GIS is that all the objects that are visible on the map also have attributes. Maps in a GIS
aren’t just pictures. They represent not only objects in locations, but also information about those objects.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 \ Follow Along: Viewing Layer Attributes

It’s important to know that the data you will be working with does not only represent where objects are in space, but
also tells you what those objects are.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas. shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.

2. In the Layer menu, click the ==/ Open Attribute Table 1yt (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.
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|L-\

\
y o f LT E & D P E = A &
full_id osm_id osm_type boundary is_in leisure name type wikidata
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884
2 w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL

1

T show All Features _

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

wil

en:Bc

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is
called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar

with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see

on the Map Canvas.

Note: In order to understand what the fields and attribute values represent, one may need to find documen-
tation (or metadata) describing the meaning of the attribute values. This is usually available from the creator

of the data set.

1. Go back to the main QGIS window.

-

2. In the Edit —> Select menu, click on the 5% Select Feature(s) button.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Artribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *

/ 2 B 0§ LT ES P PE EDe

full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ 2|8
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You can also select a feature using the Attribute Table.

1. In the A#tribute Table window, on the far left, click on the row number of the record that is currently not

selected.
( protected_areas : Features Total: 2, Filtered: 2, Selected: 1 - O X
/ < ® 08 TV E S P P E = Fe
full id osm id osm type boundary is in leisure name type wikidata Wi
i) r2855697 protected_a... |[Western Ca... [nature_reser...
187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL NULJ

4

T show All Features _

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.
3. To deselect the feature, go to the Attribute Table window and click on D..-_f] Deselect all features from the layer ¢y,

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

() protected_areas : Features Total: 2, Filte

J Q ® 0§

full id osm id osm type
1

2 w1870559

Select All

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature
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Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

You may now close the attribute table.

3.1.2 \ Try Yourself Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?

2. Tell us a bit about the t own places in your dataset.

3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,
and why?

Answer

* There should be 9 fields in the rivers layer:

1.

2.

3.

Select the layer in the Layers panel.

Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View » Toolbars menu).

Count the number of columns.

A quicker approach could be to double-click the rivers layer, open the Layer properties » Fields tab, where you
will find a numbered list of the table’s fields.

* Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

¢ The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 In Conclusion

You now know how to use the attribute table to see what is actually in the data you're using. Any dataset will only
be useful to you if it has the attributes that you care about. If you know which attributes you need, you can quickly
decide if you're able to use a given dataset, or if you need to look for another one that has the required attribute data.

3.1.4 What’s Next?

Different attributes are useful for different purposes. Some of them can be represented directly as text for the map
user to see. You'll learn how to do this in the next lesson.

3.2 Lesson: Labels

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

The goal for this lesson: To apply useful and good-looking labels to a layer.

3.2.1 \ Follow Along: Using Labels

First, ensure that the “2k=! button is visible in the GUI:
1. Go to the menu item View » Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the ‘2zl toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to ‘2tz Single Labels

You'll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:

64 Chapter 3. Module: Classifying Vector Data



QGIS Training Manual

Layer Styling )
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=1 Single Labels - ||
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Value |abc name ~ || E
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= Save Settings...
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7. Click Apply

The map should now have labels like this:
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3.2.2 \ Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Note: Above, you used the button in the Label Toolbar to open the Layer Styling panel. As with Symbology,
the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you'll use
the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the ‘=E2| Labels tab

3. Make sure Text is selected in the left-hand options list, then update the text formatting options to match those
shown here:
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That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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You'll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the

map:
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Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2 . 0 Millimeters:
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10. Click Apply

You'll see that the labels are no longer overlapping their point markers.

3.2.3 / Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the pointsinthe places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large
scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.
1. Open the ‘2| Labels tab of the Layer Properties dialog for the places layer

2. Select the Placement option from the options list
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3. Click on the Offset from point button

This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:
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4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0. 0:
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5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover

in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.24 / Try Yourself Customize the Labels

* Reset the label and symbol settings to have a point marker and a label offset of 2 . 0 Millimeters.

Answer

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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* Set the map to the scale 1: 100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Answer

One possible solution has this final product:
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To arrive at this result:

e Use a font size of 10

* Use an around point placement distance of 1.5 mm

¢ Use a marker size of 3.0

mm

* In addition, this example uses the Wrap on character option:
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* Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.25 / Follow Along: Labeling Lines

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but
what about lines? If you label them the same way as the points, your results would look like this:

(2 *basic_map - QGIS 3efaebidf1 — O x
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Processing Help

INEBRRE M*LLPHPRL AL BLEOR G -H - 8- G-FME#I s~ 0

M@V A W@ L -2 R B BN I A |

Browser
ORT® 6

~ 7 Favorites |
» [ QGIS-Training-Data\
~ [ QGIS-Training-Data\s
P[] styles
» Q basic_map
UI| Spatial Bookmarks
Project Home
[&] Home
7
@ GeoPackage
, Spatialite
W@ postals
P mssaL

E Vector Tiles
bR XVZ Tiles
& wes i
7 WFS/ OGC API - Feature
@ ows

@ ArcGisMapServer —
ey - Mt
1 = D
Layers
< @ w ? -l »
[] ® places

roads
~— rivers
B buitdings
. water
. protected_areas
landuse
| Q Type to locate (Cirl+K) | Coordinate | 20.5190,-33.3845 | % Scale [1:35434  + | (@ Magrifier 100% 2| Rotation | 0.0° [2] ¥ mender @ Epsciazs @

We will now reformat the roads layer labels so that they are easy to understand.
1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area

5. In the Labels tab’s Placement tab, choose the following settings:
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You'll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the Text to use a dark-grey or black Color and the Buffer to use a light-yellow Color.
The map will look somewhat like this, depending on scale:
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You'll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:

3.2. Lesson: Labels 79



QGIS Training Manual

@ Layer Properties - roads | Labels

=1 Single Labels -
Information Value | abc name - || &

w Text Sample

g

Source
Symbology Larem Ipsum
Labels b
Lorem Ipsum % | | 1:8860 - | | B~ v
D Masks o Rendering
¥ (4] - -
- + . - a
¢ Diagrams s Farmatting
abe B ffer Pixel size-based visibility (Jabels in map units) E,
E Fields abc) pqask
Minimum 3 px = L
Background
E Attributes Form . g 5
J Shadow Maximurn 10000 px - L
Joins }” Callouts
\ .:’ Placement Label zindex | 0,00 - E.
e i uxiliary Storage / Rendering Show all labels for this layer (induding colliding labels)
@ . Data defined
o Actions
) Show label 4= | Alwaysshow L
- Display Show upside-down labels
: ® never | | when rotation defined always
Rendering
o Featu i
Variables bt re options
~ Label every part of multi-part features
H Metadata vea e E’
v Merge connected lines to avoid duplicate labels
ﬁ Dependencies Limit number of features to be labeled to
Legend 2000 v
Suppress labeling of features smaller than
IE QGls
5.00 mm -
B oigitizing -
Style * 0K, Cancel Apply Help

7. Click OK
Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5.00 mm and
note the results when you click Apply

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Here’s the result:
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As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them
follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads
rather than float in space between them. You can decide which of these options to use, depending on what you think
seems more useful or what looks better.

3.2.6 & Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer

2. Reactivate labeling for the places layer

3. Open the attribute table for places via the button

It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the \= button next to the Italic text button beneath Style and select Edit... to open the Expression